An Arduino-Based Handheld UVI meter
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Chapter 20 in my 2019 book, Exploring Your Environment with Arduino Microcontrollers, discusses
measuring the UV Index (UVI) using a Vishay VEML6075 two-band UVA and UVB sensor breakout
board. That chapter even included a breadboard test layout for a UVI meter intended for outdoor
measurements. It used an UNO, a TFT display that I happened to have on hand, and a 9 V battery for power
—not at all a practical solution for a usable instrument!

This document describes a much more practical solution. It assumes that you already have some
familiarity with Arduinos and the Integrated Development Environment (IDE). The project also serves as
an introduction to using one of adafruit.com’s “Feather” development boards. The project is easily modified
for measuring other things, such as indoor or outdoor visible light intensity, simply by using one or more
different sensors. The parts for the UVI meter include:

Adafruit Feather 32u4 Basic Proto board, ID 2771

12- and 16-pin headers, Adafruit header ID 2886 or similar

VEMLO6075 UV breakout board, SparkFun SEN-15089 or DFRobot SEN0303

IZOKEE 0.96" monochrome OLED display or similar, from Amazon or other online sources

LiPo battery, 500 mAh (Adafruit ID 1578) or smaller, or similar

Mini breadboard (170 contacts), various online sources

ABS screw-lid project box, Hammond 1591 (4.47%2.4” x1.2") or similar

on/off pushbutton (e.g. adafruit.com ID 3870) or small SPST or SPDT toggle or slide switch
(e.g., allelectronics.com CAT# MTS-4 or SSW-86)

#22 AWG solid wire, a few inches in various colors (red, black, yellow, blue)

Superglue, silicon caulk, or hot glue gun

As of late 2020, Vishay discontinued production of the VEML6075 due to a reported “lack of
demand,” although at the time this document was being written breakout boards with this sensor were
still available from the vendors listed above. Adafruit’s VEMLG6075 board (the one used in Brooks’ book)
is no longer available. The VEML6070 UVA sensor, which does not provide even an estimate of the UV
index, is also discontinued. The Sil145 sensor, available on a breakout board from Adafruit, provides
an estimate of the UV index based on measurements of visible and IR radiation rather than on actual
UV measurements, so its accuracy is questionable. Replacing the VEML6075 sensor with an Sil145
requires installing the relevant software library and rewriting the code using examples provided; this
should not be a difficult task and, in fact, the Sil145 code will be simpler than the SparkFun code for its
VEMLG6075 breakout board. As of this writing, I'm unaware of any direct replacement for the
VEMLG6075.

The heart of this project is Adafruit’s Feather 32u4 Basic Proto development board, which is ideal for
battery-powered applications. It has built-in USB connectivity for programming through the Arduino IDE
(unlike a Pro Mini, for example). But the significant advantage for a project like this is that it has an
on-board LiPo battery charger that automatically switches back and forth between USB power when it’s
connected to a computer and battery power when it’s used offline. Under USB power the battery charges
automatically so you don’t need to remove it from the system and use a separate charger.

For the data display, I used an inexpensive IZOKEE I12C 12864 pixel 0.96” monochrome white-on-
black OLED — $13 through Amazon for a set of three at the time I wrote this document. Software libraries
for these small SSD1306 OLEDs are widely available. Graphics capabilities are available, but for this
project I used just a subset of a library to display text and numerical values. The code shown below may
not work for other OLEDs without changing the board setup; code examples provided with software
libraries usually include a long list of possible board specifications.



Using the 32u4 with the Arduino IDE

You must install the required files before you can use the 32u4 Basic Proto board, as it’s not part of a
standard Arduino IDE installation. First, go to File->Preferences and add the URL shown below. If there
are already links in the Additional Boards Manager URLs, add the one shown after a comma at the end
of the list or followed by a comma at the beginning of the list.
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Then, go to Tools>Boards—>Board Manager. Type in 32u4 and install the package. On my system,
the files are already installed.
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When you write your sketch, scroll down through the supported boards until you find Adafruit Feather
32u4. Do not compile your sketch with any other board choice! (If you try to upload a sketch compiled for
another board, Adafruit says you may “brick” the Feather 32u4.) The image below shows how to change
the board from an UNO, used for a previous project, to the Feather 32u4.
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To check that the board is working, you can upload a “blink” sketch. Make sure you’ve chosen the
32u4 board from the list of available boards. Connect the USB cable and select an appropriate COM port,
which depends on your computer’s operating system; this image is from my Windows 10 desktop.
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Then click on the . button to compile and upload the sketch.

void setup () {
Serial.begin (9600) ;
pinMode (13, QUTPUT) ;

}

void loop () {
digitalWrite (13,HIGH);
Serial.println ("ON") ;
delay (2000) ;
digitalWrite (13, LOW) ;
Serial.println ("OFF");
delay (1000) ;



A problem with Adafruit’s Feather boards (and not just the 32u4) is that they can be very finicky about
uploading sketches even when the correct board and port have been selected — a problem never seen with
boards such as the UNO. This appears to be especially true if the sketch currently in memory is trying to
write to the COM port window (i.e., with Serial.print () commands). Here’s what Adafruit’s
documentation says about their Feather boards:

Manually bootloading

If you ever get in a 'weird' spot with the bootloader, or you have uploaded code that crashes and doesn't auto-reboot
into the bootloader, double-click the RST button to get back into the bootloader. The red LED will pulse, so you know
that its in bootloader mode. Do the reset button double-press right as the Arduino IDE says its attempting to upload the

sketch, when you see the Yellow Arrow lit and the Uploading... text in the status bar.

On the 32u4 board you must press the (very tiny!) reset button twice, rapidly, at just the appropriate
time. In practice, I’ve found that it’s often necessary to repeat this operation several times, restarting the
entire compile/upload process, to get the timing right before a new sketch will upload. It’s frustrating, but
eventually it will work.

I’ve also found that some sketches requiring access to connected hardware won’t reliably compile at
all. One way to get around these problems, for reasons I don’t understand, is to disconnect power to all
peripherals from the board before compiling and uploading the sketch; this is easy to do with breadboard
layouts. The code won’t run, of course, if the peripherals — sensors, display devices, etc. — that the code
expects to see aren’t there, but once uploaded, you can disconnect the USB cable, re-connect everything,
and then connect the USB cable or battery.

Designing the meter

Figure 1 shows a breadboard layout for testing the
UVI meter with a SparkFun VEML6075 breakout board,
running from a LiPo battery. (As noted above, the 32u4
board automatically switches power between a USB cable
and a battery when it’s connected.) Following Adafruit’s
documentation, do not connect any battery other than a
3.7-4.2 V LiPo to the board! (You might be tempted
because, for example, Adafruit sells a 3-battery AAA
holder with an on/off switch and 2-pin JST connector just
like the one found on a LiPo battery.)

Also, and very importantly(!), note that the red and B —
black wires from this LiPo battery have been cut, | Figure 1. Breadboard layout for UVI meter.
reversed, and re-soldered. To its credit, Adafruit warns specifically against using other than their own LiPo
batteries if for no other reason than the positive and negative leads from other batteries may be reversed!
By design, JST connectors can be mated in only one orientation. The positive lead, conventionally red, must
be the lead closest to the end of the board with the USB connector, as shown. The wires on the “offshore”
500 mAh LiPo battery I used for this project were, in fact, reversed for the wiring on the 3u4. (I checked
polarity with a voltmeter and a cable that terminates the JST connections with jumper wires for use with a
breadboard. You should do the same if you use a non-Adafruit LiPo battery!)

By the way, although it’s true that powering this layout with a USB cable will simultaneously charge a
connected battery, this can take a long time! For this typically low-power project layout, the LiPo battery |
used started out at 3.79 V (near the “nominal” voltage for these batteries). It took almost 3 hours to “top
off” at 4.2 V. The fact that the 32u4 isn’t a particularly fast LiPo charger isn’t necessarily a problem, but
just something to keep in mind. The project will continue to run with a battery voltage as low as roughly
3.5 V or so. A fully charged 500 mAh battery will run the project continuously (not its intended mode of
operation) for several hours (I haven’t tested the limits), even with the extraneous “power on” LED on the
SparkFun VEML6075 board.
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For mounting later in a project box, I soldered four wire connections to the VEML6075 board rather
than using a Qwiic connector; the two black rectangles on the board are for Qwiic cables.' There is a red
LED power-on light in the upper left-hand corner.

Hookup to the Feather board is straightforward with the I2C UV sensor and OLED devices. The 32u4
is a 3.3 V board. The SparkFun VEML6075 board specifies a 3.3 V operating voltage and the DFRobot
version specifies 3.3-5 V. (Many other Arduino boards like the 5 V UNO have a 3.3 V power output pin.)

Finally, there are some software matters to deal with. The code for this

project uses the U8x8lib text-only subset of the U8g2lib OLED-compatible o clie
graphics library, as shown in Figure 2. The easiest way to install this library is °_=|* Uggz'fb""p
to select Sketch->Include Library=>Manage Libraries from the IDE and & UBg2libh

type u8g2 in the search box.
The default 8X8 font is pretty small, so a 16X16 pixel font (no more than 8 & Uskdlibh

characters per line) will be used to display the UVI value. Then (just to show
how to do it) the code will switch back to an 8X8 font (no more than 16
characters per line) to display the LiPo battery voltage when it’s connected, to
let you know when the battery needs recharging by switching to power from a
USB source.

Figure 2. Libraries for
the UVI meter’s text-
only OLED display.
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You will also need to install a VEML6075 software library for whichever board you use. (Although the
sensor itself is the same on all the boards, the library written by one vendor won’t work with a board from
another vendor.) At the time this document was being written, the search from the IDE found libraries for
Adafruit’s discontinued VEML6075 board and SparkFun’s VEML6075 board, which is what I used for this
project. If you use DFRobot’s VEML6075 board, you will have to download and install their library
manually. Shut down your IDE, download the library, unzip it, and copy its folder into your Arduino’s
libraries folder.

1 The SDA and SCL 12C wire colors on SparkFun’s Qwiic connect cables are different from the colors | use for my
projects, yellow for SDA and blue for SCL, which | chose long before SparkFun developed their Qwiic system.
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Here’s the code for this project. If you use an OLED from a source other than [ZOKEE you may need
to change the board definition, the U8X8... line in the code.

// VEML6075 SparkFun OLED.ino, D. Brooks, November 2020
// Displays SparkFun VEML6075 UV Index on 128x64 px IZOKEE 0.96" OLED.
// For explanation of preset values see
// https://cdn.sparkfun.com/assets/3/9/d/4/1/designingveml6075.pdf
// IMPORTANT NOTE: As of late 2020, Vishay's VEML6075 is discontinued,
// but SparkFun’s board is still available.
#include <Wire.h>
#include "U8x8lib.h"
U8X8 SSD1306 128X64 NONAME HW T2C u8x8 (/* reset=*/ U8X8 PIN NONE);
#include <SparkFun VEML6075 Arduino_Library.h>
VEML6075 uv; // Create a VEML6075 object
#define VBATPIN A9 // Pick up LiPo voltage from pin 9.
const long int delayTime=2000L;
float batVv;
void setup (void) {
Wire.begin () ;
u8x8.begin () ;
Serial.begin (9600) ;

if (uv.begin() == false) {
Serial.println ("Unable to communicate with VEML6075.");
while (1) ;

}
uv.setIntegrationTime (VEML6075::IT 100MS) ;
uv.setHighDynamic (VEML6075: : DYNAMIC NORMAL) ;
}
void loop () {
u8x8.setFont (u8x8 font px437wyse700a 2x2 r);
u8x8.setCursor (0,1);
u8x8.println (" UVI="); u8x8.print (' '); u8x8.println(getUVI()):;
u8x8.setFont (u8x8 font chroma48medium8 r);
batV=3.3* (analogRead (VBATPIN) *2) /1023; // See Adafruit docs.
u8x8.print (" Vbat = ");u8x8.println (batV);
delay(delayTime) ;
}
float getUVI() {
// Calibration constants (lab calibration bypassed) :
const float CAL ALPHA VIS = 1.0; // UVA / UVAgolden
const float CAL BETA VIS = 1.0; // UVB / UVBgolden
const float CAL GAMMA IR = 1.0; // UVcompl / UVcomplgolden

6



const float CAL DELTA IR = 1.0; // UVcomp2 / UVcomp2golden
const float UVA RESPONSIVITY = 0.00110; // UVAresponsivity
const float UVB RESPONSIVITY = 0.00125; // UVBresponsivity
// UV coefficients:
const float UVA VIS COEF A = 2.22; // a
const float UVA IR COEF B = 1.33; // b
const float UVB VIS COEF C = 2.95; // c
const float UVB IR COEF D = 1.75; // d
uintl6é t rawA, rawB, visibleComp, irComp;
float uviaCalc, uvibCalc, uvia, uvib, uvi;
// Read raw and compensation data from the sensor
rawA = uv.rawUva() ;
rawB = uv.rawUvb () ;
visibleComp = uv.visibleCompensation();
irComp = uv.irCompensation () ;
// Calculate the simple UVIA and UVIB to calculate the UVI signal.
uviaCalc=(float)rawA- ((UVA VIS COEF A*CAL ALPHA VIS*visibleComp)/CAL GAMMA IR);

uviaCalc-=((UVA IR COEF B*CAL ALPHA VIS*irComp)/CAL DELTA IR);
uvibCalc=(float) rawB- ( (UVB_VIS COEF C*CAIL BETA VIS*visibleComp)/CAL_GAMMA IR);
uvibCalc-=((UVB_ IR COEF D*CAL BETA VIS*irComp)/CAL DELTA IR);

// Convert raw UVIA and UVIB to values scaled by the sensor responsivity
uvia = uviaCalc * (1.0 / CAL ALPHA VIS) * UVA RESPONSIVITY;

uvib = uvibCalc * (1.0 / CAL BETA VIS) * UVB RESPONSIVITY;

// Use UVIA and UVIB to calculate the average UVI:

return uvi = (uvia + uvib) / 2.0;

You can find code examples with more information about the preset values used to interpret raw data
and access other VEML6075 features in the SparkFun software library.

Building the meter

Figure 3 shows the completed meter, built in an ABS project box from allelectronics.com, CAT#
MB-132, The top image in the upper left-hand cell of the table shows some headers soldered onto the 32u4
board. The upper and lower headers use the 3.3V and ground buses provided on the board for connecting
power to other devices. The pins for each of the other two headers are soldered together on the underside
of the prototyping area of the board, to provide connection points for [12C devices.

The other image in the upper left-hand table cell shows connections inside the project box. The LiPo
battery is held in place with a dot of hot glue and its positive lead goes through the small toggle switch.

The front of the box, roughly 2"x4" (5cmx10cm), is shown in the upper right-hand cell. (The blue
plastic rectangle holding the OLED display, attached to the project box with superglue, is there only due to
the fact that I had to cover over a cutout for that display that I made in the wrong place.) The OLED is
attached to the back of the plastic rectangle with hot glue.

The other two cells show the side of the box, with the switch and USB port, and the SparkFun
VEMLG6075 on the top, with its four leads inserted through a slot cut in the top of the box and fastened to
the project box with hot glue. The two small black rectangles on the sensor are for chaining mutitiple [12C
devices through SparkFun’s Qwiic connecting cables — not needed for this project. With the sensor at right
angles to the display, the UV readings can be taken pointed up at the sky or directly at the sun while the
display remains in shadow, to make it easier to read.



Figure 3. Completed UVI project.

How Does the U.S. EPA Calculate the UV Index?
It’s important to understand that the EPA’s
reported UV index, UVI, for a particular day and
location is based primarily on mathematical
models, calculated at local solar noon, rather than
on-site measurements. That model takes into
account solar elevation angle, Earth-Sun distance,
stratospheric  ozone, cloud conditions, air
pollutants, surface albedo, and surface elevation.
All these factors determine the total amount of UV
radiation reaching Earth’s surface. The amount of
UV radiation as a function of wavelength is then
weighted by the sensitivity of Caucasian skin over
those wavelengths. This weighting is called the
McKinlay-Diffey erythemal action spectrum. The
weighted incident UV radiation reaching Earth’s
surface, typically around 250 mW/m? under a
cloud-free summer sky at midday in temperate
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Figure 4. McKinlay-Diffey weighted UV action
spectrum.

latitudes, is then (arbitrarily) divided by 25 to give the UVI — 10 when the weighted UV radiation is 250

mW/m?>.




Thus, to accurately reproduce the calculations required for
calculating the UVI, it’s necessary to measure UV radiation
across a wide range of wavelengths. Inexpensive sensors like
the VEMLG6075 (~$7 on a breakout board) use two or even one
UV sensors with a relatively small range of wavelength
responsivity — see Figure 5 — and model the sensor’s response
to the rest of the erythemal action spectrum. So, it’s necessary
to view the results from such sensors with some skepticism.
Having said that, even if these inexpensive devices don’t
produce UVI values that agree with EPA’s values, they are at
least based on measurements rather than models and will still
produce interesting and very usable results.

Some resources:
https://www.epa.gov/sunsafety/calculating-uv-index-0
https://en.wikipedia.org/wiki/Ultraviolet_index
https://www.ncbi.nlm.nih.gov/pmc/articles/PMC5086780/
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Figure 5. Wavelength response of
VEMLG6075 UV sensors.
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